Computerized Payroll
Accounting

The Computerized Payroll Accounting User’s Guide (UG) is available online at
www.cengagebrain.com and is helpful for completing the computerized payroll
project within Appendix A.

This edition of Payroll Acconnting contains two different options for student so-
lution: the complete, full version of the payroll project (which follows), and a short
version. Both versions are identical except the short version requites only the comple-
tion of the December payrolls (as well as the last quarter and annual tax reports and
forms). The short version’s step-by-step instructions begin on page A-16 of this ap-
pendix. Be sure to ask your instructor which of the two versions you are to complete.

PAYROLL PROJECT

The payroll project that follows is the computerized version of the same project
you completed manually in Chapter 7 beginning on page 7-7 of this text. In this
project, you are employed by Gio-Brite Paint Company as the person in the
accounting department responsible for the company’s payroll processing using
the computerized payroll system described in the preceding material.

Like the manual project in Chapter 7, you will assume that the payroll
records, tax reports, and deposits have been Completed and filed for the first three
quarters of this year. Your work will involve the computer processing of the
payrolls for the last quarter of the year and the completion of the last quarter and
annual tax reports and forms. You may complete the required deposit, quarterly,
yearly, etc., forms desceibed in Chaprer 7. If you have already completed these
forms for the manual student project, check them as you progress through this
project and note any differences.

To help you get started, the first pay period is provided as a tutorial problem
that illustrates the principles and procedures required to process payroll transac-
tions using the Payroll Accounting 2014 software. In subsequent pay period
processing, whenever a new operational procedure is used for the first time, addi-
tional instruction will be provided. Each of the following step-by-step instructions
lists a task to be completed at the computer. I you need additional explanation
for the rask, a page reference is provided from the “Computerized Payroll
Accounting User’s Guide” via www.cengagebrain,com,

Note: Throughout this project, some of the computer-calculated withholding
amounts (e.g., federal income tax) will differ slightly from the amounts (from the tax
tables) in the manual payroll project in Chapter 7. This occurs because the computer
uses the annualized method to compute withholding taxes. Also, one- to two-cent
differences will occur throughout the solutions because of rounding differences.

CENGAGENOW

a—

General Ledger

The Computerized Accounting Pay
roll Project in Appendix Ais "
designed to be completed uslng the
General Ledger Software CD that it
provided with this text. The instruc
tions in Appendix A follow the 56
ware version of the Computerized
Payroll Project. The Computerized-
Payroll Project is also available in
Cengage Learning’s General Ledgér
platform, which is available within
CengageNOW. Separate instruict .
tions are provided directly Withm
CengageINOW for comp]etloﬂ %
online,
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OCTOBER 9 PAYROLL

Step 1:  Remove the Student Project Audit Test found on page A-29. Answer
the questions for the October 9 payroll as you complete processing
for the pay period.

Step 2:  Start up the Payroll Accounting 2014 software {page UG-2).

Step3:  Load the opening balances template file, Payroll File 2014.IA7
{page UG-3).

Pull down the File menu and choose the Open menu command.
Select Payroll File 2014.1A7 from the File list box and click on OK.

Step4:  Enter your name in the User Name text box and click on OK.

Step 5:  Enter the employec maintenance data (page UG-12).

Click on the Accts. toolbar button. Select employee number 180
(Student), key your name in the Name ficld (enter your last name in
all capital letters similar to the other employees), then click on the
Change Employee command button.

Note: Do not change any of the other fields. If you do, your solutions
will not be correct.

Step 6:  Enter the Payroll transactions, Do not deduct Group Ins—do deduct
Union Dues for the appropriate employees—do not deduct Simple Plan
{(which is the same as Simple Contributions Payable) (page UG-12).
Click on the Payroll toolbar button. Click on the Deductions button.
When the Voluntary Deductions dialog box appears, select only the
Union Dues deduction, and then click on OK. Enter the payroll trans-
action data provided below on the blank line at the bottom of the cell
grid (the existing data are beginning balances and should not be
altered). Have the computer calculate taxes. The Voluntary Deductions
dialog box will appear again while entering the first employee’s data to
let you verify that only the Union Dues deduction has been selected
ithis will occur whenever the date entered in the Date field is changed).

Note: It is very important that you enter the correct date (10/09/--)
when entering the payroll transactions. Payroll processing is date
sensitive and will accumulate and display incorrectly if the dates are
entered incorrecely, Also, be sure to enter the correct Union Dues
($8.00) for the two appropriate employees. (The $72.00 amounts that
are shown are carried over from the opening balances.)

Employees to Be Paid This Pay Period

Employee Employea Salary/ Dvertime Overtime Group Unian
Mumber Name Reg. Hrs. @ Time 1% @ Doukle Ins. Dues
100 Bonno, Anthony Victor 80 $8.00
110 Ferguson, James Claude reg. salary
120 Ford, Catherine Louise reg. salary
130 Mann, Deway Wilson reg. salary
140 O'Neill, Joseph Tyler req, salary
150 Russell, Virginia Alcise reg. salary
160 Ryan, Norman Alten 86 $8.00
170 Sokowski, Thomas James rag. salary
180 Student {your name) 1
190 Williams, Ruth Virginia rag. salary

Step 7:  Display the employee list report (page UG-20).
Click on the Reports toolbar button. Choose the Payroll Reports
option. Select the Employee List report, and then click on OK.
The report is shown in Figure A-1. Verify the accuracy of the
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Step 8:

Step 9

maintenance input and make any corrections via the Employees tab in
the Account Maintenance window.

Display the payroll report {page UG-21).

Make sure the Run Date is set to 10/09/-; then choose the Payroll
Report option and click on OK. The payroll report for Employee 100;
Bonno, Anthony Victor, followed by the payroll summary is shown in
Figure A-2 on page A-4.

Generate and post the journal entry for the current payroll {page UG-13).
Choose the Current Payroll Journal Entry menu item from the
Options menu. Click Yes when asked if you want to generate the
journal entry. When the entry appears in the Current Payroll Journal
Entries dialog box, as shown in Figure A-3 on page A-4, click on Post.
The journal entry will reappear, posted, in the general journal,

If your journal entries do not match those shown in Figure A-3,
check your employee list and payroll report for keying errors, and
make the necessary corrections, Return to the General Journal win-
dow, delete the incorrect entries, and generate new entries.

FIGURE A-1

Employee List Report
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FIGURE A-2

Poyro” Repor? {Employee 100 and Summary)
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FIGURE fi=3

Current Payroll Journal Entry
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Step 10:

Generate and post the employer’s payroll taxes journal entry
(page UG-13).

With the General Journal window still displayed, choose Employer’s
Payroll Taxes from the Options menu. Click Yes when asked if you
want to generate the journal entry. When the entries appear in the

Payrol! Taxes Journal Entries dialog box shown in Figure A-4, click

on Post. The journal entries will reappear, posted, in the general

journal.
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FIGURE A-4
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Employer's Payrolt Taxes Journal Entry
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Step 11:

Enter and post the October 9 general journal entry to record the

deposit of cash for the total net amount owed to employees in the

payroll cash account (page UG-19),

Click on the Journal toolbar button. When the General Journal tab
appears, enter the journal entry illustrated in Figure A-5. Be sure to
enter a reference of General to indicate that the entry was entered

manually in the general journal.
Step 12:

Display the general journal report (page UG-21).

Click on the Reports toolbar button, Choose the Journals option and
the General Journal report, then click on OK. When the Journal
Report selection window appears, choose the Customize Journal
Report option. Make sure the Start Date is set to 10/01/-- and the End
Date to 10/09/-- (where - is the current year), and then click on OK.

FIGURE A-5

General Journal Entry to Record Payroll Cash
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FIGURE A=6
General Journal Report
Glo-Brite Paint Company
General Journdl
10/09/--
Date Refer. Acct, Title Dehit Credit

10409 Payroll 54 Plant Wages 4,902.00
10/09 Payroll 53 Sales Salaries 3,600.00
10/09 Payrali 52 {ffice Salaries 3,353.08
10/08 Payrolt 51 Administrative Salaries 2,307.69
10/09 Payroll 21 Employaes FIT Payable 934,38
10/09 Payrel! 25 Employees SIT Payable 434.82
10409 Payroil 20.1 FICA Taxes Payabie—0ASDI 67809
10/09 Payroll 20.2 FICA Taxes Payable—HI 205.37
10/09 Fayroll 28 Employess CIT Payable 566.30
10409 Payroll 28 Unien Duss Payable 16,00
10/08 Payrofl 25.1 Empioyees SUTA Payable 9.94
10/08 Payrell 12 Payroll Cash 13,077.87
10/09 Pay. Tax 56 Payroll Taxes 123114
10/09 Pay, Tax 20,1 FICA Taxes Payable—0ASDI 5§75.09
10/09 Pay, Tax  20.2 FiGA Taxes Payable—HI ) 205.36
10/09 Pay, Tax 22 SUTA Taxes Payabls 12800
10/09 Pay, Tax 2] FUTA Taxes Payable 15.68
10/09 General 12 Payroll Cash 11.077.87
16/09 General " Cash 11,077.87

Totals 26,471.78 26,471.78

Step 13:

Step 14:

Step 15:

Step 16:

Note: If the wansactions were entered correctly, the Start and End’
Dates will be the default dates set automatically by the computer.
The computer uses the first day of the month as the Start Date and the
latest date of the general journal transactions that were entered as the
End Date, The General Journal report is shown in Figure A-6.

Display the general ledger report (page UG-21).

Choose the Ledger Reports option and the General Ledger report,
and then click on OK. When the Account Range dialog box appears,
click on OK to accept the default range of all accounts. The General
Ledger report is shown in Figure A-7.

Generate a labor distribution graph (page UG-23).

Click on the Graphs roolbar button. Click on the Labor Distribution
button to generate the graph shown in Figure A-8.

Use the Save As command to save your data to disk (page UG-10).
Choose Save As from the File menu and save the file to your disk and
folder with a file name of 10-09 your name (where 10-09 is the pay
period date),

End the payroll accounting session (page UG-11),

Cheose Exit from the File menu.

Note: If you are using this product as a distance or online course, and
your instructor has provided you with histher e-mail address, you
may e-mail each of your pay period solution files as an e-mail attach-
ment for electronic checking. Simply create an e-mail addressed to
your instructor, identifying yourself as a payroll accounting student,
and atrach your completed pay period solution file {e.g., file 10-09
your name). Your instructor will electronically check your work and
then send you a report of the results,
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FIGURE A-7
General Ledger Report
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OCTOBER 23 PAYROLL

The step-by-step instructions for completing the October 23 payroll (for the
period ending October 17) are listed below.

Step 1:  Answer the questions for the October 23 payroll on the Student
Project Audit Test as you complete processing for the pay period.
Step2:  If you quit the software after processing the previous pay period,
perform the following steps: _
a. Start up the Payroll Accounting 2014 software.
b. Load your file containing the last pay period data {10-09 your
name).
Step3:  Enter and post the October 20 transaction required to record the
deposit of the Pennsylvania state income taxes withheld from the
October 9 payroll.
Step 4:  Enter the following payroll transactions. Do deduct Group Ins—do
deduct Union Dues for the appropriate employees—do not deduct
Simple Plan (which is the same as Simple Contributions Payable).
Note: Be sure to enter the correct Group Insurance amount for each
employee {the default amounts that appear are carried over from the
opening balances). Also, since the union dues entered in the previous
payroll are assumed by the computer to be the same for future pay
periods, it will not be necessary to enter these amounts again. How-
ever, it is a good idea to verify that they are the same as those in the
payroll transactions below.
Employees to Be Paid This Pery Period
Employee Employee Salavy/ Dvertime Dvertime: Group Union
Mumber Name Reg. Hrs. @ Time 1% @ Double Ins. Dues
100 Bonno, Anthony Victor 80 4 $16.50 $8.00
110 Ferguson, James Claude req. salary $26.40
120 Ford, Catherine Louise req. salary $1050
130 Mann, Dewey Wilscn reg, salary $15.90
140 0'Neill, Joseph Tyler rag. salary $27.00
150 Russell, Virginia Aloise reg. salary $ 810
180 Ryan, Norman Allen 80 8 $16.80 $8.00
170 Sokowski, Thomas James reg. salary $24.00
180 Student {your name} 72 $ 6.30
190 Williams, Ruth Virginia req. salary $14.40

Step 5t
Step 6:
Step 7:
Step 8:

Step 9:
Step 10:
Step 11:

Step 12:

Step 13:

Display the payroll report.

Generate and post the journal entry for the current payroll.

Generate and post the journal entry for the employer’s payroll taxes.
Enter and post the October 23 general journal entry to record the
deposit of cash for the total net amount owed to employees in the
payroll cash account.

Display the journal report for 10/10/-- through 10/23/--,

Display the general ledger report.

Generate a labor distribution graph.

Note: The graph depicts the distribution of the gross amount of wages
paid to each salaries expense account for the current month (sum of
the data from the October 9 and October 23 payrolls).

Use the Save As command to save the October 23 payroll to disk with
a file name of 10-23 your name (where 10-23 represents month 10,
day 23).

Proceed to the November 6 payroll. If necessary, end your payroll
acceunting sessiorn.
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NOVEMBER 6 PAYROLL

The step-by-step instructions for completing the November 6 payroll {for the
petiod ending October 31) are listed below.

APPENDIX A » Computerized Payroll Accounting A-9

Step 1:  Answer the questions for the November 6 payroll on the Student
Project Audit Test as you complete processing for the pay period.
Step 2:  If you quit the software after processing the previous pay period,
perform the following steps:
a. Start up the Payroll Accounting 2014 software.
b. Load your file containing the last pay period data (10-23 your
name).
Step 3:  Enter and post the following transactions:
November 4: Deposited the Pennsylvania state income taxes withheld
from the October 23 payroll.
November 6: Paid the treasurer of the union the amount of union
dues withheld during the month of October,
Step4:  Enter the foliowing employee maintenance:
Change Virginia Russell’s number of withholding allowances to 2.
Change Thomas J. Sokowski’s marital status to Single (his number of
withholding allowances remains.at 2). Change Dewey Mann’s num-
ber of withhelding allowances to 0.
Step 5:  Eanter the following payroll transactions. Do not deduct Group Ins—
do deduct Union Dues for the appropriate employees—do not deduct
Simple Plan {which is the same as Simple Contributions Payable), Ver-
ify that Group Insurance is not deducted and that Union Dues are
deducted for the appropriate employees,
Note: Enter the amounts shown for Virginia Russell and Ruth
Williams to override their regular salary amounts.
Employees to Be Paid This Pay Period
Employee Employee Salary/ Overtime Overtime Group Union
Mumher Name Reg. Hrs. @ Time 1% @ Douhle Ins, Dues
100 Bonno, Anthony Victor 80 $8.00
110 Ferguson, James Claude reg. salary
120 Ford, Catherine Louise reg. salary
130 Mann, Dewey Wilson reg. salary
140 0'Neill, Josaph Tyler reg. salary
150 Russell, Virginia Aloise $572.94
{loss of 2 hours)
160 Ryan, Norman Alien 80 $8.00
170 Sokowski, Thomas Jamas reg. salary
180 Student (your name) 72
190 Williams, Ruth Virginia $1,207.85
(loss of 1 hour)
Step 6: Display an employee list report.
Step 7:  Display the payroll report.
Step 8:  Generate and post the journal entry for the current payroll.
Step 91 Generate and post the journal entry for the employer’s payroll taxes.
Step 10:  Enter and post the November 6 general journal entry to record the
deposit of cash for the total net amount owed to employees in the
" payroll cash account,
Step 11:  Display the journal report for 10/24/.- through 11/06/--.
Step 12:  Display the general ledger report.
Step 13:  Generate a labor distribution graph.
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Step 14:  Use the Save As command to save the November 6 payroll to disk
with a 4le name of 11-06 your name (where 11-06 represents month
11, day 06).

Step 15:  Proceed to the November 13 payroll, If necessary, end your payroll
accounting session. -

NOVEMBER 13 PAYROLL

A special payroll needs to be run to process a discharged employee (Ruth
Williams has been discharged because of her excessive tardiness and absentee-
istm). The step-by-step instructions for completing the November 13 special
payroll are listed below.

Step 1:  Answer the questions for the November 13 payroll on the Student
Project Audit Test as you complete processing for the pay period.
Step2:  If you quit the software after processing the previous pay period,
perform the following steps:
a. Start up the Payroll Accounting 2014 software.
b. Load your file containing the last pay period data (11-06 your
name).
Step 3:  Enter Ruth V, Williams’ payroll transaction (do deduct Group Ins of
$14.40).
Enter $2,079.32 in her salary [two partial weeks of work ($856.24),
plus two full weeks’ pay ($1,223.08) in liew of two weeks’ notice for

her final pay].
Step 4:  Display the payroll report.
Step 5:  Generate and post the journal entry for the cusrent payroll.
Step 6:  Generate and post the journal entry for the employer’s payroll taxes.

Step7:  Enter and post the November 13 general journal entry to record the
deposit of cash for the total net amount of Ruth Williams’ pay in the
payroll cash account.

Step & Display the journal report for 11/07/-- through 11/13/--.

Step 9:  Display the general ledger report.

Step 10:  Use the Save As command to save the November 13 payroll to disk
with a file name of 11-13 your name (where 11-13 represents month
11, day 13).

Step 11:  Proceed to the November 20 payroll. If nccessary, end your payroll
5€s81011.

NOVEMBER 20 PAYROLL

The step-by-step instructions for completing the November 20 payroli {for the
period ending November 14} follow.

Step 1:  Answer the questions for the November 20 payroll on the Student
Project Audit Test as you complete processing for the pay period.
Step2:  If you quit the software after processing the previous pay period,
perform the following steps:
a. Start up the Payroll Accounting 2014 software.
b. Load your file containing the last pay period data (11-13 your name).
Step 3:  Enter and post the following transactions:
November 16: Deposited with City Bank the amount of FICA taxes
and federal income taxes for the October payrolls.
Hint: Display the general ledger report to obtain these amounss from
the FICA Taxes Payable—OASDI, FICA Taxes Payable—FIl, and the
e e __Employees FIT_payable account.balances as of October 23.
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November 16: Deposited the city of Philadelphia employees withheld
income tax ($1,125.25) with the Department of Revenue for the
October payrolls (see the Employees CIT Payable account balance in
the general ledger report). .

November 18: Deposited the Pennsylvania state income taxes with-
held from the November 6 and 13 (Ruth V, Williams) payrolls.

APPENDIX A » Computerized Payroll Accounting A1

Step 4:  Enter the following employee maintenance:
Add new employee: Employee number 200; WOODS, Beth Anne;
8102 Franklin Court, Philadelphia, PA 19105-0915; social security
number, 000-00-1587; single, salaried, $1,200.00; number of pay
periods per year, 26; withholding allowances, 1; Account No. 52
(Office Salaries).
Step 51 Enter the following payroll transactions. Do deduct Group Ins—do
deduct Union Dues for the appropriate employees—do deduct Simple
Plan (which is the same as Simple Contributions Payable) for the
appropriate employees. Verify that Group Insurance is deducted, that
Union Dues are deducted, and that Simple Plan {Simple Contributions
Payable) is deducted for the appropriate employees., Note: This is the
first pay in which the company offers a savings incentive match plan,
The computer software has been designed to use the key terms “Sim-
ple Plan” to instruct it to exclude this deduction from the employee’s
income for FIT purposes. The general ledger account Simple Contri-
butions Payable is associated with this term for updating during pay-
roll transaction processing.
Employees to Be Paid This Pay Period
Employee Employee Salary/ Dvunime Overtime Group Union Simple
Numher Name Rayg. Hrs. @ Time 1% @ Douhle Ins. Dues Plan
100 Bonno, Anthony Victor 64 $16.50 $8.00
110 Ferguson, James Claude req. salary $26.40 $500.00
120 Ford, Catherine Louise reg. salary $10.50
130 Mann, Dewey Wilson req. salary $15.90 $250.00
140 0'Nsill, Joseph Tyler reg. salary $27.00 £700.00
150 Russell, Virginia Alcise $672.94 $ 8.0
{loss of 2 hours)
160 Ryan, Norman Allen a0 $16.80 $8.00 $200.00
170 Sokowski, Thomas James req. selary $24.00
180 Student {your name} 72 $ 6.30
Step 6:  Display an employee list report.
Step 7:  Display a payroll report.
Step 8:  Generate and post the journal entry for the current payroll,
Step 9t Generate and post the journal entry for the employer’s payroll taxes.
Step 10:  Enter and post the November 20 general journal entry to record the
deposit of cash for the total net amount owed to employees in the pay-
roll cash account.
Step 11:  Display the journal report for 11/14/-- through 11/20/--,
Step 12:  Display the general ledger report.
Step 13:  Generate a labor distribution graph,
Step 14:  Use the Save As command to save the November 20 payroll to disk
with a file name of 11-20 your name {where 11-20 represents month
11, day 20).
Step 15:  Proceed to the December 4 payroll. If necessary, end your payroll

session, :
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DECEMBER 4 PAYROLL

The step-by-step instructions for completing the December 4 payroll {for the
week ending November 28) follow.

Step 1:

Step 2:

Step 3:

Step 4:

Step 5t

Answer the questions for the December 4 payroll on the Stucent
Project Audit Test as you complete processing for the pay peried.

If you quit the software after processing the previous pay period,
perform the following steps:

a. Start up the Payroll Accounting 2014 software.

b. Load your file containing the last pay period data (11-20 your name).
Enter and post the following transaction:

December 3: Deposited the Pennsylvania state income taxes withheld
from the November 20 payroll.

Enter the following employee maintenance:

Change Catherine L. Ford’s salary amount to $960.00 because of a
salary increase.

Change Virginia Russell’s salary amount to §750.00 because of a
salary increase,

Add new employee: Employee number 210; YOUNG, Paul Winston;
7936 Holmes Drive, Philadelphia, PA 19107-6107; social security
number, 000-00-6057; single, salaried, $807.70; number of pay
petiods per year, 26; withholding allowances, 1; Account No. 53
{Sales Salaries).

Enter the following payroll transactions. Do not deduct Group Ins—
do deduct Union Dues for the appropriate employees—do deduct
Simple for the appropriate employees.

Employses to Be Paid This Pay Peried

Employee
Number

100
10
120
130
140
150
160
170
180
200

Employee
Name

Bonno, Anthony Victor
Ferguson, Jamas Claude
Ford, Catherine Louise
Mann, Dewey Wilson
0'Neilt, Joseph Tyler
Russell, Virginia Aloise
Ryan, Norman Allen
Sokawski, Thomas James
Student [your name)
Woods, Beth Anne

Step 6:
Step 7:
Step 8:
Step &

Step 10:

Step 11:
Step 12:
Step 13:
Step 14:

Step 15:

Salary/ Overtime Overtime Group Union Simple
Hey. Hrs. @ Time 1% @ Double Ins. Dues Plan

80 8 $8.00
req. salary $300.00
rag. salary
reg. salary $260.00
req. salary £700.00
reg. salary

76 3 $8.00 $200.00
reg. salary

12

$1,080.00

{first payroll)

Display an employee list report.

Display a payroll report.

Generate and post the journal entry for the current payroll.

Generate and post the journal entry for the employer’s payroll taxes.
Enter and post the December 4 general journal entry to record the
deposit of cash for the total net amount owed to employees in the
payroll cash account.

Display the journal report for 11/21/-- through 12/04/--.

Display the general ledger report.

Generate a labor distribution graph.

Use the Save As command to save the December 4 payroll to disk with a
file name of 12-04 your name (where 12-04 represents month 12, day 04).
Proceed to the December 14 payroll. If necessary, end your payroll
session,
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DECEMBER 14 PAYROLL

A special payroll needs to be run to process the death of an employee (Virginia
A. Russell). The step-by-step instructions for completing the December 14 special

payroll follow,

Step 1:  Answer the questions for the December 14 payroll on the Student
Project Audit Test as you complete processing for the pay petiod.

Step2:  If you quit the software after processing the previous pay period,
perform the following steps:
a. Start up the Payroll Accounting 2014 software.

b, Load your file containing the last pay period data {12-04 your name).

Step 3:  Enter and post the following transaction:
December 9: Paid the treasurer of the union the amount of union dues
withheld during the month of November,

Step4:  Enter the employee maintenance:
Change Anthony V. Bonno’s number of withholding allowances to 5.

Step 5:  Pay Virginia A. Russell {pay will go to her estate). (Do deduct $8.70
for her Group Ins.)
Enter $1,425.16 in hersalary amount, which is two partial weeks of work
{$675.16) plus her accrued vacation pay ($750.00) for her final check.
Note: After clicking on the Calculate Taxes command button, remove
the calculated withholding amounts for FIT, SIT, and CIT by keying
zeros in these grid cells (final pay is not subject to these withholdings).

Step 6:  Display an employee list report.

Step 7:  Display a payroll report, , :

Step 8:  Generate and post the journal entry for the current payroll.

Step9:  Generate and post the journal entry for the employer’s payroll taxes.

Step 10:  Enter and post the December 14 general journal entry to record the
deposit of cash for Virginia A. Russell’s net amount in the payroll
cash account.

Step 11:  Display the journal report for 12/05/-- through 12/14/--.

Step 12:  Display the general ledger report.

Step 13:  Use the Save As command to save the December 14 special payroll to
disk with a file name of 12-14 your name (where 12-14 represents
month 12, day 14).

Step 14:  Proceed to the December 18 payroll. If necessary, end your payroll

session,

DECEMBER 18 PAYROLL

The step-by-step instructions for completing the December 18 payroll (for the
week ending December 12) follow,

Step 1;

Step 2:

Step 3:

_"’frOD’l“ th’E'BCC(‘,‘H]]JSJ."4‘13Elyl'()’l’l._": e

Answer the questions for the December 18 payroll on the Student

Project Audit Test as you complete processing for the pay period.

If you quit the software after processing the previous pay period,
perform the following steps:

a. Start up the Payroll Accounting 2014 software,

b. Load your file containing the last pay period data (12-14 your name),
Enter and post the following transactions:

December 15: Deposited with City Bank the amount of FICA taxes
and federal income taxes for the November payrolls.

December 15: Deposited the city of Philadelphia employees income tax
withheld by the Department of Revenue from the November payrolls,
December 18: Deposited the Pennsylvania state income taxes withheld
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December 18: Wrote check to Virginia Russell’s estate from the
regular cash account for the amount withheld from her December 14
pay for insurance.

Step 4t Enter the following employee maintenance: ‘

Change: Employee number 140; O’Neill, Joseph Tyler withholding
allowances to 4.
Add new employee: Employee number 220; ZIMMERMAN, Richard
Lewis; 900 South Clark Street, Philadelphia, PA 19195-6247; social
security number, 000-00-1502; married, salaried, $660.00; number of
pay petiods per year, 26; withholding allowances, 1; Account No. 52
{Office Salaries).

Step 5:  Enter the following payroll transactions. Do deduct Group Ins—do
deduct Union Dues for the appropriate employees—do deduct Simple
for the appropriate employees.

Noie: Be sure to enter the changes and amounts of Group Ins. deductions
for the new employees and the $9,00 Union Dues, as noted below. Also,
be sure to enter the change to Joseph O’Neill’s Simple Plan deduction.
Note: In this pay, O’Neill has reached the OASDI ceiling. To calculate
O'Neil’s OASDI tax, multiply the OASDI ceiling of $113,700 by
6.2% and then subtract the year-to-date OASDI taxes withheld as
reported on the December 14 payroll report. After clicking on the Cal-
culate Taxes command for O'Neill, override the calculated amount by
keying the amount calculated by hand.
Employees to Be Paid This Pay Period
Employee Employee Salary/ Overtime Overtime Group Union Simpie
Mumber Name Rep. Hrs. @ Time 1% @ Double Ins. Dues Plan

100 Bonno, Anthony Victer 80 12 $16.50 $9.00

110 Ferguson, James Claude reg. salary $26.40 $ 500,00

120 Ford, Catherine Louise reg. salary $11.10

130 Mann, Dewey Wilson req, salary $15.90 $ 250.00

140 0'Neilt, Joseph Tyler $62,307.89 $27.00 $4,000.00

(rag. salary +
$60,000.00

bonus)

160 Ryan, Norman Allen a0 7 $16.80 $9.00 $ 200.00

170 Sokowski, Thomas James reg. salary $24.00

180 Student tyour name) 7 $6.30

200 Woods, Beth Anne req. salary $14.10

210 Young, Paul Winston rag. salary $ 9.60

Step 6:  Display an employee list report.

Step 7:  Display the payroll report.

Step &  Generate and post the journal entry for the current payroll.

Step 91 Generate and post the journal entry for the employer’s payroll taxes.

Step 10:  Enter and post the December 18 general journal entry to record the
deposit of cash for the total net amount owed to employees in the pay-
roll cash account.

Step 11:  Display the journal report for 12/15/-- through 12/18/--,

Step 12:  Display the general ledger report.

Step 13:  Generate a labor distribution graph.

Step 14:  Use the Save As command to save the December 18 payroll to disk
with a file name of 12-18 your name (where 12-18 represents month
12, day 18).

Step 15:  This completes the project insofar as recording and processing the com-

R M| P thi@nal-Aet-iv-itiesi—If-neeessa-r-y,- end-your.payrellsession._____ _ _._ _ ..

puterized payroll transactions for the last quarter is concerned. Proceed
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OPTIONAL ACTIVITIES

This optional, clerical activity is provided to prepare the payroll file for the next
calendar year, and to follow the manual student project in Chapter 7. The trans-
actions have been included to illustrate different types of transactions arising in
connection with the accounting for payrolls and payroll taxes. The information
contained in the computerized payroll reports may be referenced in order to com-
plete the forms in this activisy,

Step 1:

Step 2:

Step 3:

Step 4:

Step 5:

Step 6:
Step 7:

Answer the questions for the additional transactions on the Student

Project Audit Test as you complete the journal entries.

If you quit the software after processing the previous pay period, per-

form the following steps:

a. Start up the Payroll Accounting 2014 software.

b. Load your file containing the last pay period data (12-18 your name).

Purge the payroll transactions (page UG-11).

Choose the Purge Payroll Transactions (Year-End) menu item from

the Options menu. When the dialog box appears asking if you want

to purge transactions and clear payroll for year-end, click on Yes.

Enter the following employee maintenance:

Delete employee number 150 (Virginia A. Russell).

Delete employee number 190 (Ruth V, Williams).

Use the Save As command to save the data to disk with a file name of

01-01 your name (where 01-01 represents month 1, day 01).

Note: This is the payroll file that will be used to begin processing for

the new year.

Prepare the various quarter-end und vear-end payroll tax forms, and

make the accrual eniries for the payroll at the end of the year.

Load your file containing the last pay period data {12-18 your name).

Use the information contained in the payroll accounting reports to

complete the following forms—if not completed in the Student Project

in Chapter 7. If completed in Chapter 7, check the forms and note

any differences. Refer to the February 1 narrative regarding the forms

to be completed (on pages 7-19 and 7-20) in the manual student pro-

ject in Chapter 7, if necessary.

a, Form 941, Employer’s Quarterly Federal Tax Return,

b. Form 940, Employer’s Annual Federal Unemployment (FUTA)
Tax Return.

c. Form UC-2, Employer’s Report for Unemployment Compensa-
tion-—Fourth Quarter.

d. Form W-2, Wage and Tax Statement for each employee. (Must use

W-2s from Chapter 7. W-2s generated by the software do not meet

IRS requirements.)

Form W-3, Transmittal of Wage and Tax Statements.

Pennsylvania Form REV-1667, W-2 Transmittal.

Use these amounts for the wages paid and the Pennsylvania tax

withheld for the first three quarters:

Moo

Tst $34,088.70 $1,046.52
2nd $45,535.62 $1,397.94
3rd $62,600.20 $1.921.83

g. Form 1099-MISC, Miscellaneous Income (for Virginia A. Russell).

h. Formn 1096, Annual Summary and Transmittal of U.S, Information
Returns,

1. PA Employer’s Quarterly Reconciliation Worksheet.

j. Annual Reconciliation of Wage Tax for Philadelphia.
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CENGAGENOW

Step 8:  Enter and post the following transactions:

January 6: Deposited the Pennsylvania state income taxes withheld
from the December 18 payroll.

January 8: Paid the treasurer of the union the amount of union dues
withheld during the month of December.

January 15: Deposited with City Bank, the amount of FICA taxes and
federal income taxes for the December payrolls.

January 15: Deposited the city of Philadelphia employees income tax
withheld with the Department of Revenue from the December
payrolls.

February 1: Deposited FUTA Taxes Payable for the quarter.

TFebruary 1: Paid the SUTA Taxes Payable and Employees SUTA Pay-
able for the fourth guarter.

Hint: See the SUTA Taxes Payable and the Employees SUTA Payable
account balances in the general ledger report.

Step9:  Display the journal report for January 1 of the next year through Feb-
ruary 1 of the next year.

Step 10t Use the Save As command to save your data to disk with a file name
of YR-END your name (where YR-END represents the payroll file
containing the accrual entries at the end of the year).

Step 11:  End your computer session.

PAYROLL PROJECT (SHORT VERSION)

The payroll project that foliows is a computerized short version of the same
project you completed manually in Chapter 7 beginning on page 7-16 of this
text. In this project, you are employed by Glo-Brite Paint Company as the per-
son in the accounting department responsible for the company’s payroil proc-
essing using the compuserized payroll system, However, unlike the payroll
project in Chapter 7, you will only complete the payrolls for the month of
December and the optional last quarter and year-end activities, The opening
balance file will already contain all the processing for the first two months of
the quarter.

Your work will involve the computer processing of the payrolls for the last
month of the year and the completion of the last quarter and annual tax reports
and forms. You may complete the required deposit, quatterly, yearly, etc., forms
described in Chapter 7. If you have already completed these forms for the manual
student project, check them as you progress through this project and note any
differences.

To help you get started, the first pay period of December is provided as a tu-
torial problem that illustrates the principles and procedures required to process
pavroll transactions using the Payroll Accounting 2014 software. If you
need additional explanation for the task, a page reference is provided from the
“Computerized Payroll Accounting User’s Guide” that can be accessed via
www,cengagebrain.com.

Note: Throughout this project, some of the computer-calculated withholding
amounts (e.g., federal income tax) will differ slightly from the amounts (from the
tax tables) in the manual payroll project in Chapter 7. This occurs because the
computer uses the annualized method to compute withholding taxes. Also, one-
to two-cent differences will occur throughout the solutions because of rounding
differances.




